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 WARNING

Only qualified persons knowledgeable in the installation, operation, and maintenance 
of overhead and underground electric distribution equipment, along with all associated 
hazards, may install, operate, and maintain the equipment covered by this publication . A 
qualified person is someone trained and competent in:

• The skills and techniques necessary to distinguish exposed live parts from nonlive parts 
of electrical equipment

• The skills and techniques necessary to determine the proper approach distances 
corresponding to the voltages to which the qualified person will be exposed

• The proper use of special precautionary techniques, personal protective equipment, 
insulated and shielding materials, and insulated tools for working on or near exposed 
energized parts of electrical equipment

These instructions are intended only for such qualified persons . They are not intended 
to be a substitute for adequate training and experience in safety procedures for this type 
of equipment .

NOTICE
Thoroughly and carefully read this instruction sheet and all materials included in the 
product’s instruction handbook before installing or operating an IntelliRupter PulseCloser 
Fault Interrupter . Become familiar with the Safety Information and Safety Precautions on 
pages 4 and 5 . The latest version of this publication is available online in PDF format at 
sandc .com/en/support/product-literature/ .

This instruction sheet is a permanent part of the IntelliRupter fault interrupter. Designate a 
location where you can easily retrieve and refer to this publication.

 WARNING
The equipment in this publication is only intended for a specific application . The application 
must be within the ratings furnished for the equipment . Ratings for the IntelliRupter fault 
interrupter are listed in the ratings table in Specification Bulletin 766-31 .

Qualified  
Persons

Read this  
Instruction  
Sheet

Retain this  
Instruction  
Sheet

Proper 
Application

The standard warranty contained in seller’s standard conditions of sale, as set forth in Price 
Sheets 150 and 181, applies to the  IntelliRupter fault interrupter and its associated options 
except for the control group as applicable. For these devices, the first and second paragraphs 
of said warranty are replaced by the following:

(1) (1) General: The seller warrants to the immediate purchaser or end user for a period of 
10 years from the date of shipment that the equipment delivered, with the exception of a 
radio, will be of the kind and quality specified in the contract description and will be free of 
defects of workmanship and material. Should any failure to conform to this warranty appear 
under proper and normal use within 10 years after the date of shipment, the seller agrees, 

Special 
Warranty 
Provisions
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The standard warranty contained in the seller’s standard conditions of sale, as set forth in 
Price Sheets 150 and 181, does not apply to major components not of S&C manufacture, such 
as batteries, customer-specified remote terminal units and communication devices, as well 
as hardware, software, resolution of protocol-related matters, and notification of upgrades or 
fixes for those devices. The seller will assign to the immediate purchaser or end user all manu-
facturers’ warranties that apply to such major components.

The seller’s standard warranty does not apply to any components not of S&C manufacture 
that are supplied and installed by the purchaser or to the ability of the seller’s equipment to 
work with such components.

Warranty of equipment/services packages is contingent upon receipt of adequate infor-
mation on the user’s distribution system, sufficiently detailed to prepare a technical analysis. 
The seller is not liable if an act of nature or parties beyond S&C’s control negatively impact 
performance of equipment/services packages; for example, new construction that impedes radio 
communication, or changes to the distribution system that affect protection systems, available 
fault currents, or system loading characteristics.

Warranty 
Qualifications

upon prompt notification thereof and confirmation that the equipment has been stored, 
installed, operated, and maintained in accordance with recommendations of the seller and 
standard industry practice, to correct the nonconformity either by repairing any damaged 
or defective parts of the equipment or (at seller’s option) by shipment of necessary replace-
ment parts. 

The seller’s warranty does not apply to any equipment that has been disassembled, 
repaired, or altered by anyone other than the seller. This limited warranty is granted only to 
the immediate purchaser or, if the equipment is purchased by a third party for installation 
in third-party equipment, the end user of the equipment. The seller’s duty to perform under 
any warranty may be delayed, at the seller’s sole option, until the seller has been paid in 
full for all goods purchased by the immediate purchaser. No such delay shall extend the 
warranty period.

The seller further warrants to the immediate purchaser or end user that for a period 
of two years from the date of shipment the software will perform substantially in accor-
dance with the then-current release of specifications if properly used in accordance with 
the procedures described in seller’s instructions. The seller’s liability regarding any of the 
software is expressly limited to exercising its reasonable efforts in supplying or replacing 
any media found to be physically defective or in correcting defects in the software during 
the warranty period. Seller does not warrant the use of the software will be uninterrupted or 
error-free.

For equipment/services packages, the seller warrants, for a period of one year after 
commissioning, that the  IntelliRupter fault interrupters will provide automatic fault isolation 
and system reconfiguration per agreed-upon service levels. The remedy shall be additional 
system analysis and reconfiguration of the  IntelliTeam® SG Automatic Restoration System 
until the desired result is achieved.
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Several types of safety-alert messages may appear throughout this instruction sheet and 
on labels attached to the IntelliRupter PulseCloser Fault Interrupter. Become familiar with 
these types of messages and the importance of these various signal words:

 DANGER

“DANGER” identifies the most serious and immediate hazards that will likely result in 
serious personal injury or death if instructions, including recommended precautions, 
are not followed .

 WARNING

“WARNING” identifies hazards or unsafe practices that can result in serious personal 
injury or death if instructions, including recommended precautions, are not followed .

 CAUTION

“CAUTION” identifies hazards or unsafe practices that can result in minor personal 
injury if instructions, including recommended precautions, are not followed .

NOTICE

“NOTICE” identifies important procedures or requirements that can result in product or 
property damage if instructions are not followed .

If any portion of this instruction sheet is unclear and assistance is needed, contact the 
nearest S&C Sales Office or S&C Authorized Distributor. Their telephone numbers are 
listed on S&C’s website sandc.com, or call the S&C Global Support and Monitoring Center 
at 1-888-762-1100.

NOTICE

Read this instruction sheet thoroughly and carefully 
before installing or operating the IntelliRupter PulseCloser 
Fault  Interrupter. 

If additional copies of this instruction sheet are required, contact the nearest S&C Sales 
Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

It is important that any missing, damaged, or faded labels on the equipment be 
replaced immediately. Replacement labels are available by contacting the nearest S&C 
Sales Office, S&C Authorized Distributor, S&C Headquarters, or S&C Electric Canada Ltd.

Understanding 
Safety-Alert 
Messages

Following Safety 
Instructions

Replacement 
Instructions 
and Labels
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 DANGER

IntelliRupter PulseCloser Fault Interrupters operate at high voltage . Failure to 
observe the precautions below will result in serious personal injury or death .

Some of these precautions may differ from your company’s operating procedures 
and rules . Where a discrepancy exists, follow your company’s operating procedures 
and rules .

1 . QUALIFIED PERSONS . Access to an IntelliRupter 
fault interrupter must be restricted only to qualified 
persons . See the “Qualified Persons” section on  
page 2 .

2 . SAFETY PROCEDURES . Always follow safe 
operating procedures and rules .

3 . PERSONAL PROTECTIVE EQUIPMENT . Always 
use suitable protective equipment, such as rubber 
gloves, rubber mats, hard hats, safety glasses, 
and flash clothing, in accordance with safe 
operating procedures and rules .

4 . SAFETY LABELS . Do not remove or obscure any 
of the “DANGER,” “WARNING,” “CAUTION,” or 
“NOTICE” labels .

5 . OPERATING MECHANISM AND BASE . 
IntelliRupter fault interrupters contain fast-moving 
parts that can severely injure fingers . Do not 
remove or disassemble operating mechanisms or 
remove access panels on the IntelliRupter fault 
interrupter base unless directed by S&C Electric 
Company .

6 . ENERGIZED COMPONENTS . Always consider 
all parts live until de-energized, tested, and 
grounded . The integrated power module contains 
components that can retain a voltage charge for 
many days after the IntelliRupter fault interrupter 
has been de-energized and can derive a static 
charge when in close proximity to a high-voltage 
source . Voltage levels can be as high as the peak 
line-to-ground voltage last applied to the unit . 
Units that have been energized or installed near 
energized lines should be considered live until 
tested and grounded .

7 . GROUNDING . The IntelliRupter fault interrupter 
base must be connected to a suitable earth 
ground at the base of the utility pole, or to a 
suitable building ground for testing, before 
energizing an IntelliRupter fault interrupter, and at 
all times when energized .

The ground wire(s) must be bonded to the system 
neutral, if present . If the system neutral is not 
resent, proper precautions must be taken to 
ensure the local earth ground, or building ground, 
cannot be severed or removed .

8 . VACUUM INTERRUPTER POSITION . Always 
confirm the Open/Close position of each 
interrupter by visually observing its indicator .

Interrupters, terminal pads, and disconnect blades 
on disconnect-style models may be energized with 
the interrupters in any position .

Interrupters, terminal pads, and disconnect blades 
on disconnect style models may be energized 
from either side of the IntelliRupter fault interrupter .

9 . MAINTAINING PROPER CLEARANCE . Always  
maintain proper clearance from energized 
components .
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The following are required to install IntelliRupter fault interrupter software on a 
computer:

• A portable personal computer with Windows 10, an Intel® Core™ i7 Processor with 
8 GB of RAM (recommended) or a dual-core processor with 4 GB RAM (minimum), a 
wireless card (onboard or USB), an Internet browser, and access to sandc.com

• Administrative privileges

• Microsoft.Net Framework Version 4.8 (To verify whether it has been installed on a 
computer, open C:\Windows\Microsoft.Net\Framework with  
Windows Explorer. If v4.8 has not been installed, download it from this link:  
microsoft.com/net.) 

Note: If the installer does not detect the correct version of .Net, it will not install 
IntelliLink6 software.

• Windows PowerShell 5.0 set for an AllSigned execution policy (RemoteSigned and 
Unrestricted execution policies will also work.) 

• Policy selection should be based on IT department security policy. The AllSigned 
execution policy will result in the appearance of a dialog box after a firmware upgrade 
has begun. 

• To perform the firmware upgrade, the Run once or Always run button must be 
selected. Selection should be based on the IT department security policy.  
Windows PowerShell comes installed by default in every Windows operating system.

Follow these steps to set the AllSigned execution policy:

STEP  1 . Click on the Windows Start button and open All Programs> 
Accessories>Windows PowerShell>Windows PowerShell (x86) to start the 
application.

STEP  2 . In the PowerShell console, type: set-executionpolicy AllSigned to set  
the policy.

STEP  3 . In the PowerShell console, type: get-executionpolicy to verify the policy 
setting.

Computer 
Requirements
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Figure 1 . The S&C Automation Customer Support Portal is accessed on the Customer  
Portal tab at sandc .com .

NOTICE
Remote operation of firmware version 7 .3 and later with IntelliLink Setup Software  
version 6 .12 .19 does not need to be activated and is backward-compatible with  
S&C automation controls with software revision 3 .6 .11 and later . A license-activation 
file is not required and the “Installing a License Activation File” section of this 
document can be ignored . When using IntelliLink software with any other products 
with earlier software versions in conjunction with products using software versions 
3 .6 .11 and later, an IntelliLink software license key is required .

Activating the 
IntelliLink® Setup 
Software License

The latest IntelliRupter fault interrupter software release is posted at the S&C  
Automation Customer Support Portal. This library of present and legacy software requires 
a password and gives users access to the software needed for S&C equipment operated by 
their utility. See Figure 1. Request a portal password by using this link:  
sandc.com/en/support/sc-customer-portal/.

Installing the Software on a Computer
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Figure 2 . The IntelliTeam SG software workspace on the S&C Automation Customer  
Support Portal .

Log in, download, and save the license-activation file: ActivationFile.xml as directed in 
the “Installing a License Activation File” section on “Installing a License Activation File” on 
page 9, then follow the installation steps.

When the IntelliRupter fault interrupter, 6800 Series Automatic Switch Control, or 
IntelliNode™ Interface Module software version 3.6.11 or later has been installed and 
the license-activation file has been saved, IntelliLink software can be used with these 
products.

If unable to upgrade to the version 7.3.x or later firmware version, an account is needed 
on the S&C Automation Customer Support Portal to obtain a license-activation file used 
with software versions 3.6.11 to 7.1.24. When there is no account, use this link to request 
a password: sandc.com/en/support/sc-customer-portal/.

The first step is to register computers requiring IntelliLink software. Register the 
computer MAC address for the local area Ethernet adapter. Obtain the MAC address by 
using the ipconfig/all command in the command prompt. Make sure to obtain the onboard 
physical adapter and not an add-on or wireless adapter. 

If unfamiliar with the command prompt, obtain the S&C CheckMacAddress.exe utility 
found in the IntelliTeam® SG Automatic Restoration System software workspace on the 
S&C Automation Customer Support Portal. See Figure 2. Send the MAC address in an 
email to customersupport@sandc.com with the name of the company that owns the Intel-
liLink software license, the name of the primary computer user, and the computer user’s 
email address and phone number.

To determine whether the computer has already been registered, select the Licensing 
tab to view a list of the computers registered to the account. Look for the designation of 
“INTELLILINK REMOTE” next to the computer’s MAC address.

Installing the Software on a Computer
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Activate IntelliLink software for Windows 10 on the computer:
Save the ActivationFile.xml file in the folder:

C:\Users\Public\Public Documents\S&C Electric

This directory supports multiple users logging remotely into a Windows server.

Save a license-activation file on a computer:
STEP  1 . Go to sandc.com, click on the Customer Portal tab, and click anywhere in 

the left column. Click on the S&C Automation Customer Support Portal 
option. Enter the appropriate username and password to gain access.

STEP  2 . Select the Licensing tab and verify there is a valid license and the correct 
MAC address for the computer.

STEP  3 . Select the Activation File tab. This generates a new license-activation file 
with the present information displayed at the Licensing tab. Then, the File 
Download dialog box opens.

STEP  4 . Click on the Save button and the Save As dialog box opens; save 
“ActivationFile.xml” on the desktop.

Note: IntelliTeam® Designer software requires an account to have at least one asset  
registered with an IntelliTeam Designer slot. See S&C Instruction Sheet 1044-570, 
“IntelliTeam® Designer: User’s Guide” for more information about how to install and 
activate IntelliTeam Designer.

Installing a License 
Activation File

Installing the Software on a Computer
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Follow these steps to download the IntelliRupter fault interrupter software installer:

STEP  1 . Go to the S&C Automation Customer Support Portal and open the  
“IntelliRupter Fault Interrupter Software” workspace.

STEP  2 . Download the IntelliRupter fault interrupter software installer program.  
Save the installer to the computer desktop. If unable to find the “IntelliRupter 
Fault Interrupter Fault Interrupter Software” workspace, contact  
GSMC@sandc.com, and access to the “IntelliRupter Fault Interrupter 
Software” workspace will be provided for the utility.

Note: Administrative privilege is required to install IntelliRupter fault interrupter 
software.

To install the IntelliRupter fault interrupter software on a computer:

STEP  1 . Click on the downloaded IRInstaller.x.x.x.x.exe file, and it will self-extract to 
start the installation process.

STEP  2 . The IntelliRupter Software Installer screen will appear, as shown in 
Figure 3.

IntelliRupter® 
Fault Interrupter 
Software Installer

Figure 3 . The IntelliRupter fault interrupter Software Installer screen .

Installing the Software on a Computer
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STEP  3 . The software installer will guide the user through the installation process.

STEP  4 . Select these updates: 

• IntelliRupter Screenset and Applications

• IntelliLink Setup Software

• Curve Library

• LinkStart (Wi-Fi connectivity)

• Event Summary Viewer

• WaveWin

• Copy Sample Files to Selected Folder (after install)

STEP  5 . When checking the IntelliRupter Screenset and Applications check box, the 
Choose Revisions to Install dialog box will open and provide a check box for 
each available screenset that is not already installed on the computer. Check 
the revisions to install and click on the OK button. See Figure 4.

Figure 4 . The Choose Revisions to Install dialog box for the IntelliRupter fault interrupter 
screenset .

STEP  6 . If the utility operates any other S&C controls, check the IntelliLink software  
for Other Products check box, and this version of IntelliLink software will also 
be configured to communicate with S&C controls other than the IntelliRupter 
fault interrupter.

Installing the Software on a Computer
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Figure 5 . The first dialog box of the IntelliRupter fault interrupter Setup Wizard .

STEP  7 . Several of the installers install sample files to folders under the Shared 
Documents folder. To move those sample files to another location, select the 
last check box labeled Copy Sample Files to Selected Folder (after Install). If 
this option is selected, a dialog box will open that allows selecting the location 
and/or creating a new folder for the sample files after all of the selected compo-
nents have been installed.

Note: The Version Currently Installed column will show “Not Installed” the first time the 
software is installed in an IntelliRupter fault interrupter control module. 

Note: Each checked box signifies a different software component that will be installed 
separately, and each component will have its own installer.

STEP  8 . After verifying the requirements have been met, click on the Install button.

STEP  9 . A dialog box displays the next component to be installed and its version 
number. Click on the Next button to continue. See Figure 5.

STEP  10 . Click on the Next button to proceed, and then click on the Install button on 
the screen that automatically opens.

Installing the Software on a Computer
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Figure 6 . Installation complete . Click on the Finish button to run the next installer .

STEP  11 . When “Installation Complete” is displayed, that component has been installed. 
Click on the Finish button, and the installer for the next component will 
start. Follow the screen prompts to install each component. Depending on the 
options selected, some installer screens may look different from what is  
shown in Figure 6.

Installing the Software on a Computer
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Figure 7 . Installed IntelliRupter fault interrupter software revisions are shown when 
installation is complete .

STEP  12 . When installation is complete for all selected components, the IntelliRupter 
Software Installer dialog box will open and show the revision number of each 
installed software component in the right-hand column. See Figure 7.

STEP  13 . When the Copy Sample Files to Selected Folder (after Install) check box is 
selected before clicking the Install button, a dialog box opens to allow the 
user to choose the location of the sample files. When checking the Copy 
Sample Files to Selected Folder option, refer to Figures 8 through 11 on 
page 15. Otherwise, click on the Done button to close the installer.

STEP  14 . The installer has created an S&C Electric folder on the desktop. This folder 
contains shortcuts to some of the installed components.

STEP  15 . Click on the OK button to close the installer.

Installing the Software on a Computer
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Figure 8 . Dialog box to select a sample file location .

Figure 9 . Create a new sample file folder in the S&C Electric folder .

Figure 10 . Name the new sample file folder “IR Samples,” and click on the OK button .

Figure 11 . This dialog box is displayed when the sample files have been installed .

Installing the Software on a Computer
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NOTICE
Some laptop computers may have a Wi-Fi adapter power setting set too low for 
LinkStart software to operate, resulting in the inability to connect to an IntelliRupter 
fault interrupter . For Windows 10, Wi-Fi power settings are found in the Control 
Panel . To increase the Wi-Fi power setting:

STEP  1 . Go to the Control Panel>Power Options setting .

STEP  2 . Click on the Change Plan Settings option for the present plan .

STEP  3 . Click on the Change Advanced Power Settings option .

STEP  4 . Go to the Wireless Adapter Settings>Power Saving Mode>On battery 
setting .

STEP  5 . Change the setting to either “Low Power Saving” or “Maximum 
Performance .”

STEP  6 . Click on the OK button, and then click on the Save button to save the 
settings .

STEP  7 . A reboot may be required to engage the new configuration .

The Wi-Fi adapter may have a vendor-supplied option to set the power, and many 
Intel adapter drivers provide this . Open the Wi-Fi adapter Properties dialog box, and 
on the General tab click on the Configure button . Browse the tabs to determine 
whether there is a power setting (often found in the Advanced tab) . There may be 
additional settings, such as Transmit Power, that also can affect performance .

NOTICE
Port Requirements:

• IntelliLink Setup Software has a valid port range of 20000-20999 .

• LinkStart uses the following ports:

 — TCP Remote: 8828

 — UDP Remote: 9797

These two ports can be modified . To reconfigure either port, the port number must 
be updated in both LinkStart and in the R3 Communication Module . To update a port 
in LinkStart, select the Tools and TCP/IP Port Options menu options . Then, modify 
the value .

To update a port in the R3 Communication Module, open LinkStart and select the 
Tools and WiFi Administration menu options . This will open the  
R3 Communication Module web UI Login screen . Log in to the R3 Communication 
Module, click on the Interfaces menu option, and update the port .
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Figure 12 . The Windows Start menu .

Follow these steps to establish a computer connection to the control:

STEP  1 . Click on the Windows Start button and click on the All Programs menu item. 
Open the S&C Electric folder and click on the IntelliLink icon. See Figure 12.

Figure 13 . The S&C IntelliShell—Select Connection Mode dialog box .

STEP  2 . Select the Local Connection option in the S&C IntelliShell–Select  
Connection Mode dialog box. See Figure 13.

Establishing a Serial or Wi-Fi Connection
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Figure 14 . The S&C IntelliShell—Product Selection dialog box .

Figure 15 . The Communications Parameters entries in the S&C Electric IntelliShell— 
Local Communication Setup dialog box .

STEP  3 . Select the IntelliRupter Pulsecloser option and click on the Serial button to 
make a serial connection, or click on the Wi-Fi button to make a Wi-Fi connec-
tion. See Figure 14.

STEP  4 . When the Serial button is selected:

(a) Set the Comm Port setpoint appropriate for the computer.  

(b) Set the Timeout(ms) setpoint to 1000 or longer.

(c) Set the Baud Rate setpoint. The default baud rate for an IntelliLink  
software connection is 9600. If the baud rate setting was changed and is 
unknown, use the Auto setting, and the IntelliLink software will try the 
available baud rates to attempt to make a connection.

(d) Click on the IntelliLink button. See the “Firmware” section on page 23 
when a firmware update is required. See Figure 15.

Establishing a Serial or Wi-Fi Connection
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Figure 16 . The Wi-Fi Connection Management dialog box .

STEP  5 . When the Wi-Fi button is selected:

(a) Use the Prev and Next buttons to select the control serial number, or 
enter the control serial number in the Serial Number field.

Note: The control serial number is displayed on the Setup>General>Site-Re-
lated screen in the IntelliRupter Base Serial Number field.

(b) Click on the Connect button. See Figure 16.

STEP  6 . When connected, click on the IntelliLink option to open the IntelliLink 
Setup Software. For additional information on how to connect via Wi-Fi, see 
S&C Instruction Sheet 766-528 for the SDA-4554R3 Wi-Fi module and S&C 
Instruction Sheet 766-522 for older Wi-Fi modules.

STEP  7 . The S&C IntelliLink  Loader dialog box will open followed by the S&C 
IntelliLink Log in dialog box.  See Figures 17 and 18 on page 20.  Enter the 
User Name and Password, and click on the OK button. Contact the Global 
Support and Monitoring Center at 1-888-762-1100 when assistance with these 
entries is needed.

STEP  8 . If IntelliLink software is unable to connect, the S&C IntelliLink Loader dialog 
box will display “Could not connect to device.” Check the connection and 
settings.

Establishing a Serial or Wi-Fi Connection
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Figure 17 . The S&C IntelliLink Loader dialog box .

NOTICE
With software versions 7 .3 .100 and later, the default passwords for all user accounts, 
including the Admin user, must be changed before the IntelliLink software can 
connect to and configure a control . See S&C Instruction Sheet 766-530,  
“IntelliRupter® PulseCloser® Fault Interrupter: Protection and Communication 
Setup,” for more information .

Figure 18 . The User Name and Password entries in the S&C IntelliLink Login dialog box .

Establishing a Serial or Wi-Fi Connection
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Figure 19 . The IntelliRupter fault interrupter Operation screen .

NOTICE
Wi-Fi Status and Transfer Wi-Fi configurations became no longer valid for Wi-Fi 
options shipped on or after January 1, 2021 .

STEP  9 . When the login has completed, the Operation screen appears. See Figure 19.

Establishing a Serial or Wi-Fi Connection
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If the settings file uses intelligent fuse saving, S&C recommends the intelligent fuse 
saving TCC curves be re-loaded from the newly installed Curve Library 2.3. All intelligent 
fuse saving TCC curves have been recalculated to improve coordination up to higher 
current levels, and they work universally with all fuse manufacturers.

IntelliRupter Fault 
Interrupter Settings 
File Update

Complete the following steps to save the control configuration:

STEP  1 . On the menu bar, click on the File menu item and click on the   
Save Setpoints… option. 

STEP  2 . In the Save Setpoints dialog box, click on the Select All button followed by the 
… button. See Figure 20.

STEP  3 . The Windows File Explorer screen will open. Browse to the desired storage 
location, enter a name for the settings file to be saved, and click on the Save 
button in the dialog box.

NOTICE

Updating firmware can result in loss of settings . Always save the 
settings and a snapshot file before starting a firmware update .

Save Settings

Figure 20 . The Save Setpoints dialog box .

STEP  4 . To save a snapshot (a copy of the control memory, including logs), click on the 
File menu item in the menu bar and click on the Save Memory Snapshot 
option.
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NOTICE
A remote or local update puts a control into the Prohibit Restoration state . When  
updating controls in an IntelliTeam SG system, use the following procedure:

STEP  1 . Update the control software . This can be done with IntelliLink Setup 
Software or the IntelliLink software Remote option .

STEP  2 . After the update, verify all settings were preserved .

STEP  3 . Use the IntelliTeam Designer version compatible with the firmware version 
the control is running to re-push IntelliTeam SG system configurations to 
all FeederNets that have updated devices . See S&C Instruction Sheet 
1044-570 for the firmware compatibility chart .

STEP  4 . If a device is an open point, push the configuration to both FeederNets for 
that device .

STEP  5 . Verify the team configurations .

STEP  6 . For IntelliNode modules only, set the External Device Data Updated 
setting to the Running mode .

STEP  7 . Enable Automatic Restoration mode on all updated controls .

Firmware Update

NOTICE
Two files with the same firmware version (e .g ., 7 .5 .23 and 7 .5 .36) must not be 
installed on the computer during a firmware upgrade or downgrade .

NOTICE
Upgrading firmware can result in loss of settings .  Always save the settings and 
save a snapshot file before upgrading firmware .

NOTICE
Before beginning a firmware update, verify both the new firmware version and the 
firmware version existing in the control have been properly installed on the computer 
performing the upgrade . If the existing firmware is missing, the update will not 
execute properly .

Firmware Update
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Complete the following steps to update the firmware:

STEP  1 . Start the IntelliLink software and select between a local or remote connection. 
See Figure 21.

Figure 21 . The S&C IntelliShell - Select Connection Mode dialog box . 

Figure 22 . The S&C IntelliShell - Product Selection dialog box .

STEP  2 . Select the IntelliRupter Pulsecloser option to update an IntelliRupter fault 
interrupter control. Click on either the Serial or Wi-Fi button based on the 
communication method used to connect to the control. See Figure 22.

STEP  3 . When the Serial button is selected:

(a) Set the Comm Port setpoint appropriate for the computer.  

(b) Set the Timeout(ms) setpoint to 1000 or longer.

(c) Set the Baud Rate setpoint. The default baud rate for an IntelliLink  
software connection is 9600. If the baud rate setting was changed and is 
unknown, use the Auto setting, and the IntelliLink software will try the 
available baud rates to attempt to make a connection.

(d) Click on the Update Firmware button. See Figure 23.

Figure 23 . The S&C IntelliShell—Local Communication Setup dialog box .

Firmware Update
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Figure 24 . The Wi-Fi connection Management dialog box .

Figure 25 . The connection successfully completed indication .

STEP  4 . For Wi-Fi connections, LinkStart software starts and the device serial  
number must be entered in the Serial Number field. Then, click on the Connect 
button. See Figure 24.

STEP  5 . When the connection is successful, click on the Firmware Update button. See 
Figure 25.

Firmware Update
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Figure 26 . The Tools>Firmware Update menu option .

STEP  6 . In the Tools menu on the menu bar, click on the Firmware Update menu  
option. See Figure 26.

STEP  7 . When the firmware update Choose Revision dialog box appears, select the 
firmware version to upgrade the control to. See Figure 27.

Note: This dialog box only appears if the control is already on the version the 
upgrade is being performed on. Otherwise, it will not appear, and the upgrade 
script will upgrade the control to the latest firmware downloaded on the 
computer where the upgrade is being performed.

Figure 27 . The Choose Revision dialog box for selecting the firmware version .

Firmware Update
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Figure 28 . The Firmware Update dialog box upgrade method choice for the SDA-4540R2 
control .

STEP  8 . The Firmware Update dialog box will prompt for selection of the upgrade 
method. Click on one of the options to proceed. See Figure 28 for the 
SDA-4540R2 control options and Figure 32 on page 28 for the SDA-4540R3 
options.

Note: This dialog box only appears when upgrading from software version  
7.3.x to 7.5.x or later for the SDA-4540R2 control.

 Note: For the SDA-4540R2 control, the Compact Flash option is more robust 
because it downloads the firmware image to the compact flash memory before 
applying the firmware update. This should be used when updating remotely 
because it compensates for communication disruptions but takes longer to 
perform. The Legacy option is less robust because it sends the firmware file 
to the control and applies the update without staging it in the compact flash 
memory. It should only be used with a local connection to the control.

STEP  9 . When any of the software components installed in the control have the same 
or later version number as the versions being downloaded, a message similar 
to that shown in the Upgrade Choice dialog box will open. S&C recommends 
clicking on the Yes button unless instructed otherwise by an S&C representa-
tive. See Figure 30.

Figure 29 . The Firmware Update dialog box upgrade method choice for the SDA-4540R3 
control .

Note: For the SDA-4540R3 control there are two options to perform firmware 
updates. The Differences Only option will look at the files on the control and 
only update those that require updates. The All Components option will update 
all files whether they are on the latest version or not. See Figure 29.

Figure 30 . The MCU OS revision dialog box .

Firmware Update
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Figure 31 . The Firmware Update dialog box .

STEP  10 . In the Firmware Update dialog box, click on the Yes button. See Figure 31. 
Selecting “No” will end the Update process.

STEP  11 . When upgrading the firmware from 7.3.x to 7.5.x and the Firmware Update 
dialog box prompts to retain passwords, click on one of the options to proceed. 
See Figure 32.

Note: This dialog box only appears when upgrading from software version  
7.3.x to 7.5.x. When upgrading from any release to version 7.6.x or later, the 
existing passwords will be retained. If the passwords are still at the default pass-
words, then the Admin user will be required to change them to one that meets 
the password complexity requirements upon initial login after the firmware 
update is completed.

Figure 32 . The Firmware Update dialog box requesting password retention .

Firmware Update
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Figure 33 . The Firmware Update dialog box requiring passwords that meet complexity 
requirements .

STEP  12 . If the Windows PowerShell Credential dialog box appears, enter the User Name 
and Password, and click on the OK button. Contact the Global Support and 
Monitoring Center at 1-888-762-1100 if assistance is needed. See Figure 34.

 Note: When “Yes” is selected, all user passwords are retained during the 
upgrade. However, if the passwords do not meet the complexity requirements, 
the Admin user must change them at the initial login after an upgrade to meet 
the requirements. See Figure 33. 

When “No” is selected, after the upgrade, all passwords will revert to the 
defaults. At initial login, all passwords must be changed to meet the password 
complexity requirements.

Figure 34 . The Windows PowerShell Credential dialog box .

Firmware Update
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Figure 35 . The Script completed successfully notice .

STEP  13 . When “Script completed successfully” is indicated in the Firmware Update 
dialog box, click on the Close button. See Figure 35.

NOTICE
If power is disrupted during a firmware update using the Compact Flash option, 
Cyclic Redundancy Check (CRC) errors may occur and, if seen, the compact flash 
must be formatted before another update can be attempted using the Compact Flash 
option . Or at that point, the Legacy option can be used to perform the upgrade . See 
the “Memory Formatting” section in S&C Instruction Sheet 1032-570, “IntelliLink® 
Setup Software—Compact Flash Access: Operation .”

Firmware Update
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In some cases, it may be necessary to revert to a previous version of IntelliRupter control 
firmware. Follow these steps to change to a previous version:

STEP  1 . Choose the required firmware revision and obtain the software from the  
S&C Automation Customer Support Portal. See the “Software Versions“ 
section in S&C Instruction Sheet 766-530 for more information about the  
S&C Customer Portal.

STEP  2 . Click on the Start button, and select “Control Panel.” See Figure 36.

Figure 36 . The Windows Start Menu .
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Figure 37 . The Control Panel dialog box .

STEP  3 . From the Control Panel dialog box, select “Programs.” See Figure 37.

Figure 38 . The selected program folder to be uploaded .

STEP  4 . Uninstall all IntelliRupter control software versions later than the target  
version. If there are multiple revisions, work from the latest first to the earliest 
downgrade version last.

STEP  5 . If any IntelliLink Setup Software is already installed, remove it by uninstalling 
it from the Windows program with the Uninstall option. See Figure 38.

Firmware Downgrade
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NOTICE
With software later than version 7 .3 .100, the default passwords for all 
user accounts, including the Admin account, must be changed before 
the IntelliLink software can connect to and configure a control . See S&C 
Instruction Sheet 766-530, “IntelliRupter® PulseCloser® Fault Interrupter: 
Setup,” for more information .

STEP  8 . Start the IntelliLink software. 

STEP  9 . Set the Timeout(ms) setpoint to 1000 or longer.

STEP  10 . Set the Baud Rate setpoint. The default baud rate for an IntelliLink  
software connection is 9600. If the baud rate setting was changed and is 
unknown, use the Auto setting, and the IntelliLink software will try the avail-
able baud rates to attempt to make a connection.

STEP  11 . Click on the Update Firmware button. See Figure 40.

STEP  6 . Open the Windows File Explorer screen and navigate to the program folder  
C:\Program Files (x86)\S&C Electric\Products\<product folder downgrading 
to>\Firmware\Upgrades. See Figure 39. Delete any folders that have a version 
number later than the target downgrade version.

Figure 39 . The C:\Program Files (x86)\S&C Electric\Products\<product folder>\Firmware\
Upgrades dialog box .

Figure 40 . The S&C Electric IntelliShell—Local Communication Setup dialog box .

STEP  7 . Run the installer for the target version. If the target downgrade version is 
already installed, select the Repair option when it is presented by the installer.

Firmware Downgrade
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Figure 41 . The Tools>Firmware Update menu option .

STEP  12 . Enter the Admin password when prompted to enter credentials. The default 
password can be obtained by contacting the Global Support and Monitoring 
Center at 1-888-762-1100. If the default password has been changed, enter the 
user-configured password.

STEP  13 . In the Tools menu on the menu bar, click on the Firmware Update menu item.  
See Figure 41.

STEP  14 . When the Firmware Update Choose Revision dialog box appears, select the 
desired firmware version. See Figure 42.

Figure 42 . The Firmware Update Choose Revision dialog box for selecting the firmware 
version .

Firmware Downgrade
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Figure 43 . The Firmware Update dialog box for the SDA-4540R2 control .

STEP  15 . The Firmware Update dialog box will prompt for selection of the upgrade or 
downgrade method. Click on one of the options to proceed. See Figure 43 for 
the SDA-4540R2 control options and Figure 44 for the SDA-4540R3 options.

Note: This dialog box only appears when downgrading from software version  
7.5.x or later to another 7.5 release or a 7.3 release for the SDA-4540R2 control.

 Note: For the SDA-4540R2 control, the Compact Flash option is more robust 
because it downloads the firmware image to the compact flash memory before 
applying the firmware update. This should be used when updating remotely 
because it compensates for communication disruptions but takes longer to 
perform. The Legacy option is less robust because it sends the firmware file 
to the control and applies the update without staging it in the compact flash 
memory. It should only be used with a local connection to the control.

Figure 44 . The Firmware Update dialog box upgrade method choice for the SDA-4540R3 
control .

Note: The SDA-4540R3 control has two options to perform firmware updates. 
The Differences Only option will look at the files on the control and only 
update those that require updates. The All Components option will update all 
files whether they are on the latest version or not.

Figure 45 . The Firmware Update dialog box for the SDA-4540R2 control .

STEP  16 . When any of the software components installed in the control have the same 
or later version number as the versions being downloaded, a message similar 
to that shown in the Upgrade Choice dialog box will appear.  S&C recommends 
clicking on the Yes button unless instructed otherwise by an S&C representa-
tive. See Figure 45.

Firmware Downgrade
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STEP  17 . In the Firmware Update dialog box, click on the Yes button. See Figure 46. 
Selecting “No” will end the Downgrade process.

Figure 46 . The Firmware Update dialog box .

Figure 47 . The Default Password downgrade message .

STEP  18 . When downgrading from a software version of 7.3.100 or later to a software 
release earlier than 7.3.100, a message will appear about the passwords being 
reverted to defaults during the downgrade process. Click on the Yes button to 
proceed with the downgrade. Choosing “No” will stop the downgrade process. 
See Figure 47.

Note: When downgrading from a software version 7.6.x or later to a 7.5.x or 
7.3.1x version, the passwords will always be retained. If any of the users account 
passwords are still at the default value, the Admin must change them to a 
password that meets the complexity requirements before those user accounts 
can login.

Firmware Downgrade

36  S&C Instruction Sheet 766-571  .



Figure 48 . The Windows PowerShell Credentials dialog box .

STEP  19 . If the Windows PowerShell Credential dialog box appears, enter the same 
password entered in Step 9 on page <?>. See Figure 48.

Figure 49 . The message that appears after reverting passwords to defaults after a down-
grade process completes .

STEP  20 . When downgrading from a software version of 7.3.100 or later to a software 
version 7.3.x or earlier, a message will appear about the passwords being 
reverted to defaults after the downgrade process completes. Click on the OK 
button to proceed. See Figure 49.

Firmware Downgrade
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Figure 50 . The “Script completed successfully” message .

STEP  21 . When “Script completed successfully” is indicated in the Firmware Update 
dialog box, click on the Close button. See Figure 50.

Firmware Downgrade

38  S&C Instruction Sheet 766-571  .



When two or more IntelliRupter fault interrupters use the same software version and 
a similar setup configuration, the configuration setpoint profile from one can be saved 
and loaded into the other(s). Then, only the site-related setpoints need to be adjusted. 
The setpoint profile can also be used to restore setpoints if they are lost during a 
configuration. 

Follow these steps to share a configuration:

STEP  1 . Start the IntelliLink software and connect to the IntelliRupter fault interrupter  
with the setup configuration to be saved or shared.

STEP  2 . Select the File>Save Setpoints option.

STEP  3 . In the Save Setpoints dialog box, click the check boxes for the groups to be 
saved. See Figure 51.

STEP  4 . In the Save Setpoints dialog box, specify a name and location for this config-
uration. Use the ... button for more file and folder information. Then, click on 
the Save and OK buttons.

Figure 51 . Save Setpoints dialog box .
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To configure identical IntelliTeam SG Operation screens in every team member, save 
the setpoint profile from one control and load it into the other team members. Be sure to 
name the setpoint profiles logically (for example, “Team2” for Team 2 setpoints). When 
loading a setpoint profile into another team member, the IntelliLink software automati-
cally configures the Setup>Restoration>IntelliTeam SG>Team x screen and displays the 
team number.

To save all setpoint values (including values for setpoint groups that may not have 
been configured), click on the Select All button.

NOTICE
The Security Setpoint Group setpoint is not included when the Select All button 
is used . It can be included by manually selecting its check box, but in software 
versions 7 .3 .100 and later it does not store any user passwords .

STEP  5 . Close the IntelliLink software program and disconnect the computer.

NOTICE
S&C provides default setpoint files to provide a starting point for setting up an 
IntelliRupter fault interrupter . However, the user must be logged in at the  
Administrator level to load the default files .

Sharing a Configuration
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The Setting Conversion script enables users to convert any number of saved IntelliRupter 
fault interrupter version 7.1 or 7.3 software settings files for the SDA-4540R2 control into 
version 7.3 settings files for the SDA-4540R3 control so the settings can be loaded using  
IntelliLink Setup Software.

Note: Do not select the default settings .xspt files. The script cannot convert the default 
settings .xspt files. When the converted v7.3 software opens, it uses the default settings 
for that software version.

The script does not process default settings. Default settings for each product are 
available with each release, generally located in C:\Users\Public\Documents\S&C  
Electric\Products\IntelliRupterEC.

Prerequisites to the conversion include:

• IntelliRupter fault interrupter SDA-4540R2 control software version 7.1 or 7.3 and 
IntelliRupter fault interrupter SDA-4540R3 control software version 7.3.36. Both  
SDA-4540R2 and SDA-4540R3 software versions must be installed on the computer.  
For conversions from versions 7.1 and 7.3 R2, both versions 7.1 and 7.2 R2 must be 
installed.

• The Powershell Execution Policy must be RemoteSigned or more inclusive.

Follow these steps to convert the files:

STEP  1 . Download the IntelliRupterToIREC7.3.ps1 script from the S&C Customer 
Portal and save it to a convenient location.

STEP  2 . From the Windows Start menu, click on the Windows Powershell ISE (x86) 
program.

STEP  3 . In the blue field on the Windows PowerShell ISE (x86) screen, type the path of 
the script, including the full script name (or drag and drop the file).  
For example: PS C:\users\username>C:\users\public\downloads\ 
IntelliRuptertoIREC7.3.ps1 See Figure 52.

Figure 52 . The Windows PowerShell ISE (x86) screen .
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Figure 53 . The Choose a Settings File to Load dialog box .

Figure 54 . The Source Revision Ch… dialog box .

STEP  4 . Press the <Enter> key on the keyboard to run the script. The Source  
Revision Ch… dialog box opens. See Figure 54.

STEP  5 . Select the existing revision to be converted.

STEP  6 . When the Choose a Settings File to Load dialog box opens, browse to the folder 
containing the IntelliRupter fault interrupter .xspt files based on the file selec-
tion in Step 5. Select the file(s) to be converted and click on the Open button. 
See Figure 54.

If the conversion succeeds, the converted files will be written to the “Documents\ 
S&C Electric\Products\IntelliRupterEC” folder.

Note: The converted files have the same name as the original files except:

• All instances of “IntelliRupter” are changed to “IntelliRupterEC.”

• The files have a timestamp reflecting the creation time. The script waits one second 
between each conversion. Therefore, each file will have a different timestamp to 
prevent overwriting a file with the same original name.

Settings Conversion Script
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Figure 55 . The Choose Revisions to Install dialog box .

Enabling Fast Firmware Upgrades for the SDA-4540R3 
IntelliRupter Fault Interrupter Control
The 7.6.1 software release includes a new protocol to perform fast firmware updates 
called zModem. This only works with R3 IntelliRupter controls using the standard serial 
wiring configuration.

• Firmware release (4.0.0162) for the SDA-4554R3 communication module is also 
required to enable fast firmware upgrades on the SDA-4540R3 control.

• Earlier software revisions do not have this protocol. A patch release is available to 
enable this protocol on earlier software. See Step 2 for the download options.

Note: To perform this procedure on multiple controls, the user must have Admin 
rights to uninstall and reinstall the 7.6.1 firmware on the computer. Otherwise, when 
7.6.1 firmware is installed, the upgrade script will not allow the user to upgrade to the 
zModem patch first.

Follow these steps to enable fast firmware upgrades for the SDA-4540R3 control using 
standard serial wiring:

STEP  1 . Download the IntelliRupterR3Installer-7.6.1 and the R3CM-4.0.0162 firmware 
from the IntelliRupter Software folder on the Customer Portal.

STEP  2 . Run the 7.6.1 installer and select the appropriate version 7.4 or 7.5 firmware 
patch. Select one matching the present version the R3 control is running. For 
example, when the R3 control is running 7.5.44, select the 7.5.44->7.5.82 
option. See Figure 55.
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Figure 56 . The Setup>Communications>Serial Ports screen .

Figure 57 . The Interfaces>Wi-Fi Serial Interface screen .

Note: If the control is not running one of the version 7.4 or 7.5 releases shown 
in Figure 55 (i.e., 7.4.83, 7.5.23, or 7.5.44), the control must first be upgraded to 
one of those releases as part of this step  before proceeding to Step 3.

STEP  3 . Launch the IntelliLink Setup Software and connect to the R3 control. Upgrade 
the firmware on the R3 control to the new patch release. When prompted, 
select the Differences Only option.

STEP  4 . When the R3 control firmware update is complete, update the R3 communica-
tions module to the 4.0.0162 firmware release.

STEP  5 . Launch the IntelliLink Setup Software and connect to the R3 control.

STEP  6 . Go to the Setup>Communications>Serial Port screen and change the Port 
B, WiFi Communications Baud Rate setting to “230,400.” Validate and apply 
the new setting. See Figure 56.

STEP  7 . Launch the LinkStart application and connect to the R3 communications 
module.

STEP  8 . Go to the Interfaces screen. For the Wi-Fi Serial Interface setting at the bottom 
of the screen, change the Speed setting to “230,400.” See Figure 57.

zModem Firmware Update
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Figure 58 . The Firmware Update dialog box .

Figure 59 . The version 7 .6 .1 firmware selected to uninstall .

NOTICE
These steps must be performed in the order specified or communication will be lost 
to the R3 control . The baud rate on the R3 control must be changed first . Then, the 
R3 Communication Module baud rate must be changed to match it . (If the baud rate 
on the R3 Communication Module is changed first, there is no way to communicate 
to the R3 control when it is using a different baud rate .)

STEP  9 . Re-run the version 7.6.1 installer and download the version 7.6.1 firmware.

STEP  10 . Launch the IntelliLink Setup Software and connect to the R3 control. Start the 
version 7.6.1 firmware update on the R3 control.

STEP  11 . When prompted, select the zModem option to perform the firmware update. 
See Figure 58.

NOTICE
If the Legacy option is selected instead of the zModem option, the upgrade will take 
6-8 hours to complete . S&C recommends cancelling the upgrade and relaunching 
the firmware update to select the zModem option .

When the same computer is used to perform multiple upgrades, the following 
steps must be followed:

STEP  12 . After the upgrade is complete, uninstall the 7.6.1 firmware from the computer 
by going to the Control Panel>Programs>Uninstall a program option on 
the computer and selecting the version 7.6.1 installer. See Figure 59.

STEP  13 . Repeat Steps 3 through 12 until all controls are upgraded.

Note: After the final upgrade, the version 7.6.1 firmware can remain on the 
computer, but for any future upgrades using zModem, the version 7.6.1 firmware 
must be removed before performing those upgrades.

If any issues are encountered during the firmware update process, or there are ques-
tions, contact the local S&C sales representative or call the Global Support Monitoring 
Center at 1-888-762-1100. 

zModem Firmware Update
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